GUIDE TO USING MISSOURI S&T’S PUBLICATION OPTION
THESIS/DISSERTATION WORD TEMPLATE

Office of Graduate Studies
updated Fall 2019
# Table of Contents

1) Introduction

2) Getting Started
   a) Adding Text into the Document
   b) Styles
   c) Show/Hide Button
   d) Page Breaks vs. Section Breaks
   e) Automatic vs. Manual Formatting

3) General Document Information

4) List of Styles

5) Table of Contents/LI/LT
   a) Table of Contents
   b) List of Illustrations & List of Tables

6) Formatting 1\textsuperscript{st} Level Headings
   a) Section Writing and Paper Writing
   b) Restarting Heading Numbering

7) Formatting 3\textsuperscript{rd} and 4\textsuperscript{th} Level Headings

8) Formatting Paper Writing

9) Inserting Figures and Tables
   a) For Figures
   b) For Tables

10) Inserting References and Bibliography

11) Single-spacing a Multi-lined Heading
   a) In the TOC
   b) In a 2\textsuperscript{nd} level heading

12) Too Much Space Above Headings

13) Appendix Heading Styles
   a) For One Appendix
   b) For Multiple Appendices

14) Other Recommendations
1) INTRODUCTION

The goal of the Missouri S&T Publication Option templates for Word 2016 is to help you meet campus formatting criteria for your thesis or dissertation. This guide is meant to help aid you in fixing formatting problems commonly experienced in this template. For a complete list of S&T’s formatting rules and regulations, please refer to the Thesis & Dissertation Specifications (revised January 2018).

The Word templates are located on the Office of Graduate Studies’ website, found at grad.mst.edu > Current Graduate Students > Thesis and Dissertation Information

This guide will only cover formatting for the Publication Option template.

2) GETTING STARTED

a) Adding Text into the Document

- **Option 1: Write directly into the template.**
  - You may delete the filler text within sections and replace it with your own words. You may also add new sections that are not included in the template.
  - When creating new sections, pressing **Enter** will automatically move you from Heading 1 to Heading 2, and from Heading 2 to body text.
  - We recommend typing your headings before applying heading styles, but you can also apply styles before you start typing out the heading.

- **Option 2: Copy and paste your text directly into the template.**
  - If you already have the text of your thesis or dissertation written in a separate Word file, you may copy text from that file and paste it directly into the body of the template. (You will most likely be doing this for your paper writing of the Publication Option.)
  - We recommend pasting text section by section rather than the full document all at once.
  - After pasting, go through your text and apply the correct styles, spacing, and paragraph indentation.
• **Important:** Do not copy and paste from the template into a different document. The format will not remain the same.

b) **Styles**

The template is built around Word's Styles functionality. These styles are used to define text and link to common formatting rules. For example, all 1st level headings within the body of your document should be set as Heading 1 to maintain correct formatting and numbering. These linked styles can then be used to generate the Table of Contents.

<table>
<thead>
<tr>
<th>AaBbCc</th>
<th>AaBbCc</th>
<th>AaBbCc</th>
<th>AaBbCc</th>
<th>1. AaBb</th>
<th>1.1. Aa</th>
<th>1.1.1. Aa</th>
<th>1.1.1.1. Aa</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix...</td>
<td>Appendix...</td>
<td>Figure Ti...</td>
<td>HEADING 0</td>
<td>Heading 1</td>
<td>Heading 2</td>
<td>Heading 3</td>
<td>Heading 4</td>
</tr>
</tbody>
</table>

The template contains all the styles you should need within your thesis or dissertation, and you should not need to modify their style definitions (keep in mind if you modify a style, it will change every instance of that style within your document). A full description of the template's styles can be found in Section 4 of this guide.

If you click inside any text within the template, the style it has been set to should be selected within the list of styles. To change to a different style, place your cursor inside the line of text you wish to change, and then click on the new style. By default, styles will change all text up to a carriage return. The Style Separator tool must be used to separate the first line of 3rd and 4th level headings, as shown in Section 7 of this guide.

c) **Show/Hide Button**

The Show/Hide button is located in the top right corner in the Paragraph group under the Home tab.

Clicking on this button will show you nonprinting marks within your document such as section breaks, page breaks, paragraph breaks, line breaks, tabs, and spaces.

This tool is extremely useful when working with your document’s format. If you are having formatting issues or are copying/pasting text, we recommend using this feature.
3.1 Example of a Figure with Multiple Parts and a Very Long Title That Takes Up More Than One Line

Example of the Show/Hide button revealing spaces, tabs, paragraph breaks, and a page break.

d) Page Breaks vs. Section Breaks

When using the Word templates, it is vital to understand the difference between page breaks and section breaks:
• **Page break:** starts a new page. Page breaks do not change the format between pages; they simply move your cursor down to the beginning of the next page. They can be found under the Insert or Layout tab.

• **Section break:** creates two different sections before and after the break (i.e., allows you to change the format from one page to another). Section breaks are often used to change format of page numbers or to make a single page landscape. They can be found under the Layout tab. Section breaks can be used between pages ("Next Page" break) or between parts of a single page ("Continuous" break).

Accidentally deleting a section break within the template will usually cause formatting errors and can be difficult to correct. Before deleting text on a page, always turn on the Show/Hide button to make sure you are not also deleting a section break.

© 2019

Your Full Legal Name

All Rights Reserved

If you are deleting a page with a section break, make sure there is still a section break on the bottom of the page that remains. For example, if you delete the Nomenclature page, make sure there is still a section break between the last page of your front matter and the first page of your introduction section. The exception is the flyleaf pages; these section breaks may be removed without issue.

e) **Automatic vs. Manual Formatting**

The template is built to automatically format your document to the thesis/dissertation specifications as much as possible. However, due to Word’s limitations, sometimes you will have to manually adjust the document’s formatting. The instructions in this guide will help you with the areas that need to be manually formatted.

Below is a brief list of what the template automatically formats and what will need to be manually formatted.
<table>
<thead>
<tr>
<th><strong>Automatic</strong></th>
<th><strong>Manual</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>• Double line spacing</td>
<td>• Figure and table numbering</td>
</tr>
<tr>
<td>• First-line paragraph indentation</td>
<td>• Equation numbering</td>
</tr>
<tr>
<td>• Section and subsection numbering (after manually restarting in each paper)</td>
<td>• Single-spacing and properly aligning multi-lined 2nd level headings and headings in TOC</td>
</tr>
<tr>
<td>• Space below headings in front matter (Heading 0)</td>
<td>• “SECTION” and “PAPER” labels in TOC</td>
</tr>
<tr>
<td>• Extra space above 2\textsuperscript{nd} level headings</td>
<td>• “APPENDICES” and lettering (&quot;A,&quot; “B,” etc.) written in TOC for multiple appendices</td>
</tr>
<tr>
<td>• Page numbers</td>
<td>• “SECTION” and “PAPER” labels in LI/LT</td>
</tr>
<tr>
<td>• List of headings and page numbers in TOC (after updating table)</td>
<td>• Capitalization of 1st level and 2nd level headings</td>
</tr>
<tr>
<td></td>
<td>• Page break before 1\textsuperscript{st} level headings (Heading 1) in section writing</td>
</tr>
<tr>
<td></td>
<td>• Carriage return above 1\textsuperscript{st} level headings in paper writing</td>
</tr>
<tr>
<td></td>
<td>• Carriage return below 1\textsuperscript{st} level headings when directly followed by body text</td>
</tr>
<tr>
<td></td>
<td>• Style separator after 3rd and 4th level headings</td>
</tr>
</tbody>
</table>
3) GENERAL DOCUMENT INFORMATION

- **Flyleaves:** This template has flyleaves, but these pages are optional.

- **Title page:** You should not have to adjust the spacing on the title page at all. Just replace the filler text with your own information.

- **Placeholder text:** Some sections of the template have Lorem ipsum placeholder text. This is just for a visual of what the document should look like.

- **Nomenclature:** This page is optional. Instructions for linking to the nomenclature are written in Section 1.1.3. of the template.

- **Styles:** All styles you need for the Publication Option are built into this template. Use these styles if you want to manually generate your TOC. You should not have to modify or add to these styles. Numbering should appear automatically.

- **2nd level headings:** The extra space above 2\(^{nd}\) level headings is built in. You should not have to manually space above these headings more than any other paragraph break.

- **Spacing:** Your document should be double spaced, with a few exceptions for long headings, captions, and references. A double-spaced line equals 24 pts of space. If you single-space a line for a heading, the line below it will no longer be fully double spaced. Therefore, you may have to add 12 pts of “After” paragraph spacing to maintain the look of double line spacing. This applies when single-spacing 1\(^{st}\) and 2\(^{nd}\) level headings and when inserting tables.

- **Indentation:** The indentation of body paragraphs is built into “Style Body Text.” You may have to adjust this when working with 3\(^{rd}\) and 4\(^{th}\) level headings.

- **Tables/Figures:** Note that the numbering system for tables and figures changes between section writing and paper writing and the numbering restarts with each new paper. When writing table titles and figure captions, type out the title/caption first (including number, which won’t appear automatically) and then apply the appropriate setting under Styles (either “Figure Title” or “Table Title”). Do not use “Insert Caption” under the References tab.

- **Appendices:** The Publication Option template shows formatting for multiple appendices. The traditional thesis template shows formatting for one appendix.
4) LIST OF STYLES

Note that Heading 1, Heading 2, Heading 3, and Heading 4 are used for both section writing and paper writing. Any style that starts with “Paper” is exclusively used in the paper writing.

- **Appendix Title (1):** if you only have one appendix, use this for the title under the heading “APPENDIX.” This title is optional. It will not appear in your TOC.

- **Appendix Title (2):** if you have multiple appendices, use this only for the title on the appendices’ title pages. This title will link to your TOC.

- **HEADING 0:** all headings in the front matter and back matter that appear in the TOC, and for the heading “APPENDIX” if you only have one appendix.

- **TOC Heading 1:** only used for the “TABLE OF CONTENTS” heading to avoid having it appear within your TOC.

- **Heading 1:** all 1\(^{st}\) level headings in your section writing and paper writing, such as “INTRODUCTION” or “LITERATURE REVIEW.” This heading must be written in all caps.

- **Heading 2:** all 2\(^{nd}\) level headings. This heading must be written in all caps.

- **Heading 3 and 4:** all 3\(^{rd}\) level and 4\(^{th}\) level headings. Note the proper capitalization of each heading. The body text of the following paragraph begins on the same line as these headings.

- **Style Body Text:** body text with a first-line indentation.

- **Normal:** body text without indentation.

- **Figure Title:** all figure captions. This style is automatically single spaced. Use Normal style for figures within the appendices, as these are not listed in the TOC.

- **Table Title:** all table titles. This style is automatically single spaced. Use Normal style for tables within the appendices, as these are not listed in the TOC.

- **Paper Abstract:** for the heading “Abstract” within your paper writing.

- **Paper Authors:** used if you list authors below the paper title and before “ABSTRACT” in your paper writing.

- **Paper Reference:** for the heading “References” within your paper writing.
• **Paper Title**: for your paper titles, with an uppercase Roman numeral.

• **PAPER/SECTION Heading**: can be used for the word “PAPER” and “SECTION” at the start of your papers and section conclusion. It will not link to the TOC.
5) TABLE OF CONTENTS/LI/LT

a) Table of Contents

If using styles appropriately, the TOC should generate with correct headings, indentation, and page numbers, but you will still need to make some manual modifications:

- Write the word “SECTION” on a new line between front matter and section introduction

<table>
<thead>
<tr>
<th>NOMENCLATURE</th>
<th>xii</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SECTION</strong></td>
<td></td>
</tr>
<tr>
<td>1. INTRODUCTION</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PAPER</strong></td>
<td>12</td>
</tr>
<tr>
<td>I. TITLE OF FIRST PAPER THAT WILL BE SINGLE SPACED IF IT IS LONGER THAN ONE LINE AND IT WILL BE NUMBERED WITH AN UPPERCASE ROMAN NUMERAL</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>REFERENCES</td>
<td>32</td>
</tr>
<tr>
<td><strong>SECTION</strong></td>
<td></td>
</tr>
<tr>
<td>3. CONCLUSIONS AND RECOMMENDATIONS</td>
<td>33</td>
</tr>
</tbody>
</table>

- Write the word “PAPER” on a new line before your paper writing begins

- Write the word “SECTION” on a new line after your paper writing and before your section conclusion

- Single-space multi-lined headings and make sure text is properly aligned (see Section 11a)

- Make sure punctuation after 3rd and 4th level headings is consistent
• If you have multiple appendices, write in the word “APPENDICES” on a new line before the titles appear, and add in “A,” “B,” etc. before each title

APPENDICES

A. TITLE OF FIRST APPENDIX .................................................................................. 34
B. TITLE OF SECOND APPENDIX............................................................................. 36

b) List of Illustrations & List of Tables

• Numbering style of figures and tables differs between the section writing and the paper writing.
  
  o **Section Writing** Numbered like “Section.Figure” (e.g., Figure 1.1, 1.2, 3.1).
  
  o **Paper Writing** Numbered consecutively without including section number (e.g., Figure 1, Figure 2, Figure 3). Numbering restarts with each new paper.

<table>
<thead>
<tr>
<th>LIST OF ILLUSTRATIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>SECTION</td>
</tr>
<tr>
<td>Figure 1.1. Example four-bar linkage. ................................................................. 6</td>
</tr>
<tr>
<td>Figure 1.2. Four-bar linkage – crossed configuration ............................................. 7</td>
</tr>
<tr>
<td>Figure 1.3. Example mechanism ........................................................................... 8</td>
</tr>
<tr>
<td>Figure 3.1. The is the first figure under the third 1st level heading in your section writing. ................................................................. 13</td>
</tr>
<tr>
<td>PAPER I</td>
</tr>
<tr>
<td>Figure 1. Vector loop decomposition of loop 1. ...................................................... 16</td>
</tr>
<tr>
<td>Figure 2. Caption of the second figure in this paper goes here. .............................. 17</td>
</tr>
</tbody>
</table>

• Because the numbering style changes within the LI/LT, the figure and table numbers must be typed manually whenever you insert your captions. The text that appears in the LI/LT will be exactly what you typed into the caption.
• Numbering of figures in your section conclusion continues where your section introduction numbering left off and will be placed below the figures in your paper writing.

SECTION

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>Example four-bar linkage.</td>
<td>6</td>
</tr>
<tr>
<td>1.2</td>
<td>Four-bar linkage – crossed configuration.</td>
<td>7</td>
</tr>
<tr>
<td>2.1</td>
<td>The is the first figure under the second 1st level heading in your section writing</td>
<td>13</td>
</tr>
</tbody>
</table>

PAPER I

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Vector loop decomposition of loop 1.</td>
<td>16</td>
</tr>
<tr>
<td>2</td>
<td>Caption of the second figure in this paper goes here.</td>
<td>17</td>
</tr>
<tr>
<td>3</td>
<td>Example of a figure with multiple parts and a very long title that takes up more than one line</td>
<td>20</td>
</tr>
</tbody>
</table>

SECTION

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>First figure within your section conclusion</td>
<td>33</td>
</tr>
</tbody>
</table>

• The labels “SECTION” and “PAPER #” must be added in manually.

• Follow these instructions whenever you are ready to update your LI/LT:
  
  o Right-click anywhere in the LI or LT
  
  o Select **Update Field**
  
  o Select **Update entire table**
  
  o Press **OK**
  
  o Place your cursor to the right of the page number above the line where your label should be inserted
  
  o Press **Enter**
  
  o Type the appropriate label
- Repeat inserting labels until all corresponding sections and papers are listed
- Delete all text past the first period in all captions
- Single-space captions that are more than one line long (see Section 11a)
- Remove any figures or tables that appear in your appendices

- You may instead format your LI/LT with “Figure” written as a column heading instead of beside each caption.

### LIST OF ILLUSTRATIONS

<table>
<thead>
<tr>
<th>SECTION</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1. Example four-bar linkage</td>
<td>6</td>
</tr>
<tr>
<td>1.2. Four-bar linkage – crossed configuration</td>
<td>7</td>
</tr>
<tr>
<td>2.1. The is the first figure under the second 1st level heading in your section writing</td>
<td>13</td>
</tr>
</tbody>
</table>
6) FORMATTING 1ST LEVEL HEADINGS

a) Section Writing and Paper Writing

- **Section writing**: 1st level headings should start on a new page (just like in the traditional theses/dissertations). To do this, insert a Page Break before the 1st level heading.

- **Paper writing**: 1st level headings can start on the same page as the text before them.
  - Press **Enter** twice after the previous paragraph
  - Type out heading title in all caps and set to **Heading 1**
  - Press **Enter** once to move automatically to Heading 2

```
of your headings should match your published paper.

1. INTRODUCTION

1.1. THIS IS A SECOND-LEVEL SUBHEADING

The following paragraphs demonstrate how to use a citation and a footnote.

- If you want text before Heading 2, change the style to **Style Body Text** instead of Heading 2, press **Enter** once, and begin typing your paragraph
```

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras imperdiet non nisl et.
b) Restarting Heading Numbering

- **Paper Writing** you will need to restart the numbering of the first 1st level heading that appears. The rest of the numbering within that paper should follow automatically.
  
  - Right-click Heading 1 number
  - Choose **Restart at 1**

- **Section Writing** The heading number corresponding to your section writing conclusion should pick up where the section writing introduction stopped.

  - Check your section writing introduction for the number of the last 1st level heading
  - Scroll down to your section writing conclusion and right-click the number to the left of Heading 1
  - Choose **Set Numbering Value**
○ Type in the correct heading number in the box under “Set value to”

○ Press **OK**
7) **FORMATTING 3\textsuperscript{RD} AND 4\textsuperscript{TH} LEVEL HEADINGS**

Since Word automatically treats everything up to a hard return (i.e., paragraph break) as a single style, you must manually adjust 3\textsuperscript{rd} and 4\textsuperscript{th} level headings in order for the beginning of your body text to begin on the same line. Using the Style Separator tool is recommended because it will only pull the actual heading into the TOC.

- Click the down arrow on your Quick Access Toolbar and select **More Commands**

![More Commands](image)

- Select **All Commands** from the drop-down menu
- Scroll down and select **Style Separator**
- Press **Add** and then **OK**
• In your document, type your 3rd level heading on a line by itself with the body text in a paragraph underneath it (not beside it)

This is a New 3rd Level Heading.

This is the start of my body text for this new 3rd level heading.

• Mark the heading as **Heading 3** in the Styles menu

• With your cursor within the text of your heading, click the **Style Separator** tool in the Quick Access toolbar (or press `Alt + Ctrl + Return`). Your body text should be moved up to the same line as Heading 3 and maintain the correct style

• 2.2.3. **This is a New 3rd Level Heading.** This is the start of my body text for this new 3rd level heading.
8) Formatting Paper Writing

- “PAPER” must be written above the first paper’s title (but not subsequent papers).

I. Title of first paper that will be single spaced if it is longer than one line and it will be numbered with an uppercase Roman numeral

- Paper authors are optional. If included, you must insert a carriage return in the line above the authors.
- Headings do not start on a new page (other than the paper title).
- Section breaks are not necessary.

II. Second paper title here and it should be single spaced if it is more than one line long

Student Name, Joe Smith, James B. Brown, Charles R. Jones, D. F. Lang, and Hardy Davidson

Department of Mechanical and Aerospace Engineering, Missouri University of Science and Technology, Rolla, MO 65409

Abstract

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Integer iaculis volutpat mattis. Quisque sodales consequat nibh. Phasellus aliquam, erat sit amet ullamcorper
9) inserting figures and tables

Tables and figures must have equal space above and below. Table titles go above tables, and figure captions go below figures. Follow the steps in this section to ensure your tables and figures have the right amount of space around them.

Please note that due to the nature of figure numbering within the Publication Option specifications (i.e., numbering restarts with each new paper), the Publication Option template does not support automatic numbering of figures and tables.

a) For Figures:

- Hit Enter twice after your body text
- Insert your figure (make sure it does not go past your page margins)
- Hit Enter once
- Type out the figure label, number, and caption below your figure
- Mark your caption as Figure Title under Styles
- Hit Enter twice before returning to your body text

Example of correctly formatted figure.
b) For Tables:

- Hit **Enter** twice after your body text wherever you want to insert the table
- Under the **References** tab, click on **Insert Caption**
- Make sure Label is set to **Table**, and then press **OK**
- Space once beside the table number and type out your table title
- Make sure your full caption is marked as **Caption** under Styles
- Hit **Enter** once and then insert your table
- Click into the empty space below the table (this should be there automatically; if not, insert a carriage return below the table)
- With your cursor in the empty space below the table, insert **12 pt “After” paragraph spacing**

1.3.2. **Spell Check.** Be sure to check the spelling and grammar in your document periodically. If this is not turned on automatically, you can click on **“Spelling & Grammar”** under the **Review** tab to launch a review.

Table 1.2: This is my table title that is really long and should need to be single-spaced if it isn’t single-spaced automatically.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To change or update the settings of Word’s **Spell Check**, go to File > Options > Proofing. Make sure “**Ignore words in UPPERCASE**” is turned off so that Word will still check the spelling in your headings. In the **Proofing** dialog box, you can also click on...
10) INSERTING REFERENCES AND BIBLIOGRAPHY

Double spacing should be used between each reference. References that are more than one line long should be single-spaced within.

References can be formatted alphabetically (with hanging indent) or numerically. Students may use the citation style recommended by their department, or otherwise use whichever style best suits their area of study. APA and IEEE are commonly used at Missouri S&T.

Different citation styles may be used per paper in the Publication Option (e.g., Paper I may use APA citation style while Paper II uses IEEE.)

<table>
<thead>
<tr>
<th>REFERENCES</th>
</tr>
</thead>
</table>

- **References**: Each paper in the paper writing will have its own unique set of references. These are the references that were published alongside that individual paper. Just copy and paste your paper's references into this section, and then format appropriately.

- **Bibliography**: Any citations used in your section writing (introduction and conclusion) will be listed here. You may use citation management software like Mendeley to build this bibliography, but note that Mendeley does not support multiple reference lists, so it cannot be used for the lists of references within your paper writing. If you do not have citations in your section writing, remove this page.

- **Formatting**: You may be able to paste references as **Merge Formatting** without any issue. However, formatting references can be time-consuming if they are pasted as entirely double spaced or single spaced. The following directions are the easiest way to meet formatting requirements:
  - Paste references
- Highlight all references in list
- Change to single line spacing
- Under Layout, add **15 pt “After” paragraph spacing**
- Apply hanging indent (if applicable):
  - Make sure all references are highlighted
  - Click the dialog box launcher in the lower right corner of the Paragraph group
  - Under Indentation, change “Special” to **Hanging**
- Check that none of your references are split between two pages
11) SINGLE-SPACING A MULTI-LINED HEADING

a) In the TOC:

- Highlight everything within the TOC
- Change to single spacing
- Add 15 pt of “After” paragraph spacing
- Make sure no entries are split between two pages
- If any text encroaches page number, press **Shift + Enter** (a soft carriage return) to move that text to the next line

```
3.1. HOW TO SINGLE-SPACE FIRST LEVEL, SECOND LEVEL, AND THIRD LEVEL HEADINGS ................................................................. 13¶

3.1.1. Third Level Heading ................................................................. 13¶

3.1.2. Another Third Level Heading that Demonstrates Spacing of a Very Long Title ................................................................. 13¶
```

Example of heading encroaching page number area

```
3.1. HOW TO SINGLE-SPACE FIRST LEVEL, SECOND LEVEL, AND THIRD LEVEL HEADINGS ................................................................. 13¶

3.1.1. Third Level Heading ................................................................. 13¶

3.1.2. Another Third Level Heading that Demonstrates Spacing of a Very Long Title ................................................................. 13¶
```

Text moved to next line with soft carriage returns

- Use ruler to ensure subsequent lines of heading are properly aligned
b) In a 2nd level heading:

- Change entire heading to single spacing (no paragraph breaks needed)
- Place cursor at the end of heading
- Add 12 pt of “After” paragraph spacing (located under the Layout tab or in the Paragraph dialog box)

<table>
<thead>
<tr>
<th>Indent</th>
<th>Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left: 0”</td>
<td>Before: 24 pt</td>
</tr>
<tr>
<td>Right: 0”</td>
<td>After: 12 pt</td>
</tr>
</tbody>
</table>


c) References

- Highlight all references
- Change to single spacing
- Add 15 pt of “After” paragraph spacing
- Apply hanging indent (if applicable)
  - Make sure all references are highlighted
  - Click the dialog box launcher in the lower right corner of the Paragraph group
  - Under Indentation, change “Special” to Hanging
- Make sure no references are split between two pages
If your 3rd and 4th level headings are jumping down to the next page and leaving large gaps of space above them, you are probably using an earlier version of the templates. Follow the steps in this section to correct this issue.

- Right-click the **Heading 3** style
- Select **Modify**
• Select **Format** in the lower right-hand corner of the dialog box

• Choose **Paragraph** from the menu

![Modify Style dialog box](image)

```
1.1.1. Mauris faucibus, turpis vitae maximus imperdiet arcu velit isculis libero, eu

```

• Select the **Line and Page Breaks** tab

• **Deselect** **Keep with next** and **Keep lines together**
  (Widow/Orphan control should be the only option selected)

![Line and Page Breaks tab](image)
13) APPENDIX HEADING STYLES

a) For One Appendix:
   - Use **Heading 0** for the word “APPENDIX,” which will link to your TOC.

   ![APPENDIX]
   ![TITLE GOES HERE]

   - Use **Appendix Title (1)** for the title under “APPENDIX.” This title is optional. It will not appear in your TOC.

   ![APPENDIX]
   ![TITLE GOES HERE]

b) For Multiple Appendices:
   - Use **Normal** for the first line on appendix title page (e.g., “APPENDIX B”).

   ![APPENDIX B.]
   ![TITLE OF SECOND APPENDIX]

   - Use **Appendix Title (2)** for the title on the appendices’ title pages. This title will link to your TOC.

   ![APPENDIX B.]
   ![TITLE OF SECOND APPENDIX]
• In your TOC, type in the word “APPENDICES” on a new line before your appendix titles, and add the corresponding letter (e.g., “A” and “B”) to the left of each appendix title.

<table>
<thead>
<tr>
<th>APPENDICES</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. TITLE OF FIRST APPENDIX ......................................................... 15</td>
</tr>
<tr>
<td>B. TITLE OF SECOND APPENDIX ........................................................... 17</td>
</tr>
</tbody>
</table>
14) OTHER RECOMMENDATIONS

- **TOC page numbers:** After updating the TOC and taking away extra words from 3rd and 4th level headings, always finish by "Updating Page Numbers Only."

- **Spacing around figures/equations:** You may have to manually adjust spacing around your figures and equations to make it look equal above and below, especially if your figure contains a lot of white space around the edges of the image.

- **Hiding page numbers:** If you need to hide a page number, the easiest way is to place a white box over it with no border. Just check to make sure it’s still there if your pages get shifted around.

- **Automatically updated styles:** If you make a local change to a style and find that the change syncs with your other text, right-click that style, select "Modify," and deselect "Automatically Update" to prevent this from happening.

- **Spell check:** Go to File > Options > Proofing and make sure "Ignore words in UPPERCASE" is not selected. Otherwise, Word will not catch misspellings within your major level headings.

- **Heading capitalization:** You can use the "Change Case" option in the Font group to quickly put text in all caps, and this should appear in your TOC.

- **Landscape pages:** It is easier to turn a figure sideways than to turn a page landscape. If using a table, you will need to insert it into a text box in order to turn it sideways. Make sure to keep the same margins as your other pages. If turning a page landscape, follow instructions in Appendix B for modifying page numbers.

- **Blurry Heading Numbers:** Sometimes when converting to PDF, your heading numbers or text will appear blurry. This seems to happen more frequently if you are using an outdated version of the template or a version of Office older than 2016. If this happens, highlight your heading numbers and press Ctrl + spacebar. If the problem persists, open a new copy of the template and use the Format Painter tool to copy the correct format from the template’s headings onto the blurry heading in your document.